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Introduction 
This hands-on guide will help introduce you to the RISA-3D Masonry Wall Panel functionality, while also walking you through a 

start to finish example, including helpful tips and tricks along the way. This tutorial is intended for both experienced and first- 

time RISA-3D users and can be completed in a single sitting. 

 
All the “actionable steps” in this tutorial are indicated with bullets as shown below: 

 

• Actionable Step 

This guide is intended to show teach the basics of the masonry wall panel functionality. If you have further questions that fall 

outside of the scope of this guide, please refer to the RISA-3D General Reference Guide and the online Help file. 

Note: If you are not familiar with RISA-3D, you should also complete the tutorials available on the RISA website at 

https://risa.com/documentation. 
 

The RISA-3D Masonry Wall Panel: Introduction & Tutorial is compatible with RISA-3D v18 or higher. 
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Masonry Codes & Materials 
Let’s start by setting the design code: 

• Click on the Model Settings  icon. 

• Choose the Codes tab. 

• Select the Masonry code from the drop-down list: TMS 402-16: ASD. 

• Click OK. 

Next, let’s create the material for the masonry wall: 

• Click on the Materials button on the Data Entry panel: 

• Click on the Masonry tab at the top of the dialog box 

• Change the Concrete Matl properties by typing directly in the cell: 

E = 1800 ksi 

G = 720 ksi 

f’m = 2 ksi 

 

• Click on the in the upper right corner to close the spreadsheet. 
 
 
 
 
 

 

Masonry Design Codes in RISA-3D: 

• TMS 402-16 ASD & Strength 

• ACI 530-13 ASD & Strength 

• ACI 530-11 ASD & Strength 

• ACI 530-08 ASD & Strength 

• ACI 530-05 ASD & Strength 

• ACI 530-99 ASD 

• UBC 97 ASD & Strength 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
TIP: RISA-3D has a variety of default 
material properties available; you can 
save your own default materials 
available by pressing the default icon 
at the top of the screen when the 
Materials spreadsheet is open. 
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Creating Wall Geometry 

Let’s start by drawing the wall: 

• Click on the  icon on the Draw Elements section on the Home tab. 

• You should now see the Properties Panel update with design properties 

specific to Wall Panels: 

 
 

 

You can draw a wall by clicking on existing nodes or drawing the wall using a 

grid. We will draw a wall using the drawing grid. 

Choose which type of wall: 

• Select Masonry from drop-down menu. 

• Select Material Set: Concrete Matl. 

• The mouse cursor will appear with crosshairs   and you are ready to 

start drawing. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

You must first define the material you 
want to use. The current options 
available are Masonry, Wood, 
Concrete and General. In this exercise, 
we will be drawing a masonry wall. 
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Using the drawing grid to create a 12’ high rectangular wall: 

• Click on the bottom left corner (0,0,0), 

• Move the cursor to the top right corner and left click on (12,12,0), 

• Right-click the mouse or press Esc to stop drawing. 
 
 

 
The wall panel will be created after the second click of the mouse and should 

look like the picture above. 

Let’s open the Wall Panel Editor to add openings: 

• Double click on the Wall Panel to view the Wall Panel Editor. A new Walls 

tab will appear in the Ribbon Toolbar. 
 

 

 
 
 

 
 

The Drawing Grid will help you draw 
the wall. As the cursor hovers over 
the drawing grid intersection lines, a 
red dot will appear which indicates 
where the joint will be located. 

 

 
If the grid is not visible, click the 
icon in the Drawing Tools tab. 

 

 
Notice that you can view the cursor 
coordinate information when you 
hover over an existing node or 
drawing grid intersection. 
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Next, change the drawing grid in order to locate the 

openings: 

• In the Drawing Tools section, click in the box next to Horizontal (ft), clear 
the current entry and type 2,2.5,3.5,3 

• In the Drawing Tools section, click in the box next to the Vertical (ft), clear 
the current entry and type 2@3, 1.75 

• Press the Tab key to complete the input 

The grid will automatically resize to adjust to the new scale. You can also toggle 

the grid display on and off by clicking the icon. 

 
 

 

 
 

With the grid set, create a window and a door opening: 

• Click on the Openings   icon at the top left of the Wall Panel Editor 

to create an opening. 

 
Let’s create the window opening: 

• Using the Wall Grid coordinates, left click on the bottom left corner of the 

opening (2,3,0). 

• Move the mouse to the top right corner (4.5,6,0) and left click on the grid 

intersection. 

 
Now let’s create a door opening: 

• Left click on the bottom left corner (8,0,0) 

• Move the mouse to the top right corner (11,7.75,0) and left click on the 

grid intersection. 

• Right click to end the command. 
 

 

 
 

Note: In the Drawing Grid and Wall 
Grid, you may use symbols such as: 

“@” (to specify multiple, equally 
spaced increments). 

“/” (to subdivide a larger increment 
into smaller increments). 

“,” (to enter multiple increments in the 
increment field). 

 
 
 
 

 
The Wall Grid within the Wall Panel 
Editor is a tool that guides your 
placement of openings. The grid is 
independent of your model, so you 
may change the grid as you build the 
wall without changing anything in your 
model. 
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The wall should now look like the picture shown below. 
 
 

 
 

Now we can add boundary conditions (supports): 

• Click the Create New Boundary Conditions  icon in the top left of 

the Wall Panel Editor 

• For this wall panel, we will choose the Fixed support option. 

Additionally, since the support is being assigned within the Wall Panel 

Editor, the boundary condition will be assigned as Continuous along the 

edge of the wall panel. 

• Select a node along the bottom edge of the wall panel to apply the 

boundary condition. 
 

 

• Right click to end the command. 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 

Wall Panels can have rectangular 
openings. You can click on any 
location on the grid to create an 
opening. 

Openings can be created anywhere 
on the wall panel except the upper 
and side edges. 

Note: You can utilize the Delete 
tool to remove the openings if 
you make a mistake. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Other boundary conditions can be 
used. It is possible to modify all six 
degrees of freedom in the model 
(translation in X, Y and Z and rotation 
in X, Y and Z). The preset options for 
boundary conditions include: 

Free 

Fixed 

Roller 
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Lintels 

Let’s review the lintel design parameters: 

• Double left click directly inside the window opening to view the Lintel 

design parameters, in this example select Edit/View Existing Wall Design 

Rule 
 

 

• If the lintels do not show, use the toggle  icon to turn them on. 

The lintel selection is based on the design rule assigned in the Wall Panel 

Design Rules or you can create a Custom Opening where each opening within 

the wall is defined separately. 

• Click Cancel. 

 

We will review the header Design Rule in the next section. 
 
 
 
 
 
 
 

 

 
 

Lintels will automatically be created 
and placed above the openings in 
masonry walls. 
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Assigning Design Parameter 
Regions 

Let’s define regions inside the wall for design/analysis of the 
masonry shear wall: 

• Select the Generate Wall Regions Automatically  icon. 

 

• The wall drawing should now look like the picture above. 

Let’s now review the Region Design Parameters: 

The masonry design parameters and reinforcement are specified as part of the 

Wall Design Rules. The Wall Design Rule will automatically update the design 

parameters for the entire wall. In the next section, we will review the Wall Design 

Rules. You can review the design parameter named “Typical” that is being 

applied to this wall: 

• Double left click directly inside the Region R6 and click Edit/View the 

Existing 

Wall Design Rule to view the Region Design Parameters. 
 

The information can be edited directly in this dialogue or can be edited in the 

Wall Design Rules spreadsheet. Additionally, if you need a special reinforced 

region, you can click Convert to Custom to edit only this region. 
 

 

• Click OK to close the region details. 

• Click on the in the upper right corner to close the wall panel editor. 

 
 

What is a Region? 
In RISA, we define a wall strip for 
design as a Region. In reference 
codes this is referred to as a full height 
wall segment or pier. 

 

 
Regions must be rectangular. To 
create them, use the cursor to select 
two nodes or grid intersections which 
define the lower left corner and upper 
right corner of the region. 

 

 
Note: Regions cannot overlap 
openings. 

 

 
RISA automatically creates regions for 
walls. However, it is also possible to 
manually create Regions by 

Manually icon. . 
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Wall Design Rules 

Let’s review the Design Rule from the Properties Panel of the 
masonry wall. 

• Select the masonry wall and click on the ellipsis  button next to 

Design Rule 
 

• Click Edit/View the Existing Wall Design Rule and set the wall panel 

design parameters as shown in the dialogue below. 
 

 

The dialogue allows for all of the wall design parameters to be assigned and 

modified in one location. 

• Click OK when you have assigned the parameters correctly. 

 
Wall Panel parameters can also be assigned directly in the Wall 
Design Rules spreadsheet. 

• Select Wall Design Rules from the Data Entry panel 
 

• Click on the Masonry Lintel tab and set the properties for lintel design 

as shown on the next page. 

 

 
 

Block Nominal Width: This is used to 
calculate thickness of masonry walls. 
This value is used along with the 
value of grout/bar spacing to 
determine the effective thickness of 
the wall. The effective thickness is 
based on tables B-3a and B-3b of the 
Reinforced Masonry Engineering 
Handbook, by Amrhein, Copyright 
1998. 

 

 
Block Nominal Length: This value is 
used to optimize the boundary zone 
length of the masonry walls. It is 
assumed that there are 2 cells per 
block (typical for concrete masonry) 
and based on the value of Bars Per 
Cell we can increment the value of 
the boundary zone while 
incrementing the number of bars in 
the boundary zone. 
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• Depth: 16” 

• Bearing Length: 8” 

• Bar Size: #5 

• Min # Bars Per Layer: 1 

• Max # Bars Per Layer: 3 

• Num of Layers: 1 

• c/c Sp of Layers: N/A 

• Dist to Bot: 4.5 

• Stirrup Size: #4 

• Analysis Method: Simply Support 

• Click  to exit the Wall Design Rules. 

To better view the wall, in the 3D view, click on the Rendered Icon   found  

in the Quick View section of the Home tab twice and the Snap to Isometric view 

option ISO. 

 
 

 

 
 

 

Optimizing the Wall Panels 

RISA will design and optimize the wall 
panels based on the criteria in the 
Wall Panel Design Rules. 
Additionally, there is an option in the 

Model Settings that will 

enable optimization of walls upon 
solution. If you want to check an 
existing wall, you can explicitly select 
the wall panel size and make sure to 
turn off the wall optimization. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Note: If you want to view the wall 
panel rendered at 100%, click on the 
Model View Settings button 
and click the Wall Panels tab 
and select 100% using the 
sliding scale. 
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Loading 

We first need to create the Basic Load Cases: 

• Open the Basic Load Case spreadsheet on the Data Entry toolbar or 

press the icon. 

• Type Dead Load on the first line under the BLC Description column. 

• Select DL (Dead Load) from the Category drop-down menu. 

• Type -1 into the Y Gravity column. 

 
Let’s add wind load case: 

• Type Wind Load on the second line under the BLC Description column. 

• Select WLX (Wind Load X) from the Category drop-down menu. 
 

• Type Wind Load Z on the third line under the BLC Description column. 

• Select WLZ (Wind Load Z) from the Category drop-down menu. 

• Exit BLC Spreadsheet by clicking the  on the top right corner. 

Add a distributed load to the masonry wall: 

• Click on Distributed Load icon. 

• Select Y for Direction in the drop-down menu. 

• Select Basic Load Case 1: Dead Load. 

• Type -0.1 as the Start Magnitude and the End Magnitude will 

automatically populate. 
 

• Select Click to Apply and then click on top of the wall. 
 

 
 
 
 
 

Walls can be loaded with joint, 
surface loads, or distributed loads. 

 

 
You must define the Category to use 
the Load Combination Generator. 

 

 
Typing a -1 in the Y Gravity column 
creates a Basic Load Case which 
includes self-weight. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can end any command by right 
clicking the mouse. 
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The wall should now look like the image below with the distributed load applied. 

 

 
Let’s add a point load of wind load to this wall: 

• Click on Nodal Load  icon. 

• Select LOAD (L). 

• Select Basic Load Case 2: Wind Load X. 

• Select Direction X from the dropdown list. 

• Magnitude: 2 kips 

• Select Click to Apply. 
 

• Click on or draw a box around Node N2. 

 
 

 
Nodal loads can only be applied in 
the global directions. We can tell that 
this is the global axis because the X 
is capitalized. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Wall Panels can have uniform or 
tapered surface loads. 

The direction of the load is applied to 
the Global Z direction. 

The global axis is always indicated 
with capital letters and the local axis 
is indicated by lower case letters. 

 
 

When you have openings in your wall 
panel, the load that is attributed to 
the opening(s) in the wall panel is 
applied as a transient load distributed 
around the openings. You can view 
these by going to View > Model 
View Settings > Loads > Check 
Include Transient (Wall) after 
solution. 
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The wall should now look like the image below with the point load applied. 
 

Let’s add a surface load of wind load to this wall: 

• Click on Wall Surface Load  icon. 

• Select Direction Z from the dropdown list. 

• Select Basic Load Case 3: Wind Load Z. 

• Select Tapered Load Distribution. 

• Top Magnitude: -0.02 ksf 

• Bottom Magnitude: -0.015 ksf 

• Load Height: Entire Wall 

• Select Click to Apply and click on the wall. 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Wall Panels can have uniform or 
tapered surface loads. 

The direction of the load is applied to 
the Global Z direction. 

The global axis is always indicated 
with capital letters and the local axis 
is indicated by lower case letters. 

 
 

When you have openings in your wall 
panel, the load that is attributed to 
the opening(s) in the wall panel is 
applied as a transient load distributed 
around the openings. You can view 
these by going to View > Model 
View Settings > Loads > Check 
Include Transient (Wall) after 
solution. 
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The wall should now look like the image below with the surface load applied. 
 
 

 

With the loads applied to the masonry wall, we can now create 
load combinations prior to analysis and design. 
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Load Combinations 

Let’s create the load combinations using the LC Generator: 

• Open the Load Combination spreadsheet by selecting the  Icon 

at the top of the screen. 

 
• Select LC Generator  

 

• Select United States for the LC Region. 

• Select 2018 IBC ASD for the LC Code. 

• Uncheck RLL, SL and RL 

• Click Generate to create gravity load combinations. 

• Select the Wind tab. 

• Click the X and Z button under the Wind Load Options 

• Select the Reversible checkbox. 

• Click Generate. 

• Click Close. 
 

 

 

 
 

The LC Generator allows you to create 
load combinations quickly based on 
the code you select. 
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The Load Combination spreadsheet will automatically generate all the load 

combinations from the IBC 2018 and should look like the picture below: 

• Close the LC Spreadsheet. 

Let’s review the loads as they are applied to the wall: 
 

• Toggle on the loads display by clicking the     icon if they’re not 

already turned on. 

• The load display control panel is on the top of the screen. 
 

• Click on the drop-down menu to switch Type to Load Combination. 

• Select the LC7 in the drop-down dialog. 

You should now see the Load Combination 7: IBC 16-12 (a) (b) = DL + 0.6 WLZ 

displayed on your screen as below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To display loads, we will work with the 
loading display toolbar at the top of 
the screen. 
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With all the loads applied, let’s run the analysis: 

• Click the Analysis and Design   icon. 

• Select the Envelope (Only) of Marked Combinations radio button. 

• Click Solve. 
 

 
 

 
A Single solution will only solve the 
selected load combination. An 
Envelope solution will solve multiple 
load combinations and the results will 
show only the maximum and 
minimum. The Batch solution will 
solve multiple combinations and the 
results will be retained for every 
solution. 
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Designing the Wall 

Reviewing results: 

• Select the Wall Panel Design spreadsheet from the Results panel. 
 

• To view the different results for wall panels, click on the tabs at the top: 

Masonry In, Masonry Out, Masonry Lintel. 
 

Each spreadsheet consists of design results for the wall panel broken down into 
each individual design region and includes the following information: 

 

− The Wall Panel Label and Region correspond to the wall panel labels 

and regions defined in the Wall Panel Editor. 

− The Combined UC entry gives the code check due to axial force plus 

bending. The Shear UC shows the code check for shear effects. A value 

greater than 1.0 for either of these values indicates failure. 

− The Fa or Pn*Phi reports the allowable axial stress or axial capacity. 

− The Fb or Mn*Phi reports the calculated allowable bending stress or 

moment capacity for the region. 

− The Fv or Vn*Phi reports the calculated allowable shear stress or shear 

capacity for the region. 
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The Masonry Lintel tab gives the results for the masonry lintels that span over 

user defined openings in the wall. They can also be viewed by looking at the 

detail report associated with each opening. 

− The Flexural UC entry gives the code check due to pure flexure of the 

Lintel. Axial force is not considered in this code check. The Shear UC 

gives the code check for shear. A value greater than 1.0 for either of 

these values would indicate failure. 

− The Fa or Pn*Phi reports the allowable axial stress or axial capacity. 
 

− The Fb or Mn*Phi reports the calculated allowable bending stress or 

moment capacity for the region. 

− The Fv or Vn*Phi reports the calculated allowable shear stress or shear 

capacity for the region. 
 

• Close the Wall Panel Design spreadsheet. 

Let’s take a closer look at the wall reinforcement: 

• Select the Concrete Reinforcing spreadsheet from the Results panel. 
 

• To view the different results for wall panels, click on the tabs at the top: 

Masonry Wall, Masonry Lintel. 
 

• Close the Concrete Reinforcing spreadsheet. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

For slender wall design, 
additional checks and analysis 
are required. These are reported 
in the regions detail report. 
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Detailed Reports 

Let’s take a closer look at the wall by viewing the Detail Report: 

• Click the Analysis and Design  Icon. 

• Select the Single Combination radio button. 

• Select LC7: IBC 16-12 (a) (b). 

• Click Solve. 

• Click the Detail button  on the left-hand side of the screen. 

• Click anywhere on the wall panel. The Detail Report Summary will open. 

 
Wall Summary Detailed Report 

 

 
 
 
 
 
 
 
 

 
 

The Detail Report is only available for 
Single Combination solutions or 
Batch solutions. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The top section of the Detail Report 
echoes the entire user defined input. 
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Regions In-Plane Detail Report 
 

 
 

Effective Depth: This gives you the 
distance from the compression face 
of the region to the centroid of 
tension reinforcement within that 
region. 

 
 
 
 
 
 
 

The next section will display the 
envelope axial, shear and moment 
diagrams as well as a summary of the 
code checks. 

 
 
 
 
 
 
 
 
 
 
 
 

 
The next section will provide the 
design details for axial, bending and 
shear. 

Note: You may click on any of the 
Limit States to view an expanded 
detailed calculation. 

 
 
 
 
 
 
 

The last section will provide a cross 
sectional drawing of the boundary 
zone width and reinforcement. 
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The Equivalent Solid Thickness is 

obtained by dividing the volume of 

the solid material in the wall by the 

face area of the wall. This is used in 

calculating the axial stress in the wall. 

A good reference for this value is the 

Reinforced Masonry Engineering 

Handbook, 5th ed. by James Amrhein, 

specifically, Tables B-3a and B-3b. 
 

 
The next section will display the 

envelope axial, shear and moment 

diagrams as well as a summary of the 

code checks. 

 
 
 
 

 
The next section will provide the 

design details for axial, bending and 

shear. 

Note: You may click on any of the 

Limit States to view an expanded 

detailed calculation. 

 

 
The last section will provide a cross 

sectional drawing of the Out-of-Plane 

reinforcement. 

 
 

Regions Out-of-Plane Detail Report 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

The Equivalent Solid Thickness is 
obtained by dividing the volume of 
the solid material in the wall by the 
face area of the wall. This is used in 
calculating the axial stress in the wall. 
A good reference for this value is the 
Reinforced Masonry Engineering 
Handbook, 5th ed. by James 
Amrhein, specifically, Tables B-3a 
and B-3b. 

 

 
The next section will display the 
envelope axial, shear and moment 
diagrams as well as a summary of the 
code checks. 

 
 
 
 
 
 
 
 
 

 
The next section will provide the 
design details for axial, bending and 
shear. 

 

 
Note: You may click on any of the 
Limit States to view an expanded 
detailed calculation. 

 

 
The last section will provide a cross 
sectional drawing of the Out-of-Plane 
reinforcement. 
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Lintel Detail Report 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

This section will provide the design 
details for bending and shear. 

 
 
 
 
 
 
 
 
 
 
 
 

 
Note: You may click on any of the 
Limit States to view an expanded 
detailed calculation. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The last section will provide a cross 
sectional drawing of the lintel 

 
 
 
 
 
 
 

Note: In the Help file within RISA-3D 
and the RISA-3D General Reference 
both provide explicit descriptions of 
nearly all of the values in the report. 
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Conclusion 

If you have completed the tutorial you should now be familiar with modeling, analyzing and designing masonry wall 

panels in RISA-3D. In addition to masonry wall panels, RISA-3D has wall panels in Wood and General materials. To learn 

more about the other materials or if you wish to know more about specific features, you can refer to the RISA-3D General 

Reference Guide or the Help from within RISA-3D. 

If you have any questions, comments or suggestions feel free to email us at support@risa.com or call us at 949-951-5815. 
 

Thank you for choosing RISA! 
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